
You may move from one topic to another in this Help file by clicking with the mouse on any item that is 
underlined.    From the keyboard, you may use the Tab key to highlight an underlined item, and then press 
Enter.    You may go backward, after moving to a new topic, by activating the button at the top labeled Back.    
You may return to this Contents page at any time by activating the Contents button.    You may learn more 
about how to use a Windows Help file by pressing the F1 key, or you may choose "How to Use Help" from the 
Help Menu.
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ProGuard V.2.0 Copyright 1994 Frederick Wasti.    All Rights Reserved.

CETUS SOFTWARE AND FREDERICK WASTI DISCLAIM ALL WARRANTIES RELATING TO THIS 
SOFTWARE, WHETHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, 
AND ALL SUCH WARRANTIES ARE EXPRESSLY AND SPECIFICALLY DISCLAIMED.    NEITHER 
CETUS SOFTWARE NOR FREDERICK WASTI SHALL BE LIABLE FOR ANY INDIRECT, 
CONSEQUENTIAL, OR INCIDENTAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE
SUCH SOFTWARE EVEN IF CETUS SOFTWARE OR FREDERICK WASTI HAS BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES OR CLAIMS.    IN NO EVENT SHALL THE LIABILITY OF 
CETUS SOFTWARE OR FREDERICK WASTI EVER EXCEED THE PRICE PAID FOR THE LICENSE TO
USE THE SOFTWARE, REGARDLESS OF THE FORM OF THE CLAIM.    THE PERSON USING THE 
SOFTWARE BEARS ALL RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE.

This agreement shall be governed by the laws of the Commonwealth of Massachusetts and shall inure to the 
benefit of Cetus Software and/or Frederick Wasti, and any successors, administrators, heirs, and assigns.    Any 
action or proceeding brought by either party against the other arising out of or related to this agreement shall be
brought only in a state or federal court of competent jurisdiction located in the Commonwealth of 
Massachusetts.    The parties hereby consent to in personam jurisdiction of said courts.

This software and the disk on which it is obtained is licensed to an individual or institution user, for his/her/its 
own use.    This is copyrighted software.    The user is not obtaining title to the software or any copyright rights. 
The user may not sublicense, rent, lease, convey, modify, translate, convert to another programming language, 
decompile, or disassemble the software for any purpose.    The user may make one copy of the software for 
back-up purposes only.    The user may use this software on his/her/its own computer(s) only.

See also:

ProGuard Overview
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ProGuard is a Windows utility designed to make it impossible for guest users to run selected programs simply 
by double-clicking on their icons in Program Manager.    Once a particular program's icon has been protected 
by ProGuard, the guest user will find that trying to run the program will cause ProGuard to run instead, and 
that a password will be needed before the actual program will start.    Logical icons to protect might include 
those for Windows Setup, Control Panel, PIF Editor, System Editor, File Manager, and the MS-DOS Prompt, 
and it is a simple matter to add ProGuard's protection to any other application's icon, as well.

ProGuard V.2 can also prevent the guest user from starting any program that is not present as an icon in 
Program Manager, and can prevent the guest user from creating, copying, moving, or deleting icons, or 
changing their properties.

See also:

ProGuard's Windows
Program Security
Protection Shield Settings
Password Protection
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ProGuard consists of three windows, a Password Entry Window (used to enter the correct ProGuard password),
a Protection Shield Window (used to enable or disable ProGuard's Protection setting), and a New Password 
Window (used to change the working ProGuard password).

The Password Entry Window is accessed when ProGuard first runs.    The Protection Shield and New Password
Windows are reached from the Password Entry Window, to which they return when they are closed.    The 
protected application starts up after the Password Entry Window is cleared.

See also:

Password Entry Window
New Password Window
Protection Shield Window
Overview of ProGuard
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The Password Entry Window, which is the opening ProGuard window, appears in two forms, depending on 
whether a command line has been specified for ProGuard to run (the left window) or not (the right window).

Click on any window control for information on its function:

See also:

ProGuard's Windows
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The New Password Window is used to change the working ProGuard password.

Click on any window control for information on its function:

See also:

ProGuard's Windows
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The Protection Shield Window is used to change the ProGuard Protection setting.

Click on any window control for information on its function:

See also:

ProGuard's Windows
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It is a simple matter to add ProGuard's protection to any application's icon by adding "run " (including the 
trailing space) before the program's filename in the File Properties dialog box.    Then, when the icon is 
activated by the user, run.exe (ProGuard's executable program filename) will run first, and only after getting 
past a password hurdle will the guest user be able to get the actual program to start.    (Of course, the ProGuard 
Protection setting must be "Exposed", in order to change any Properties box entries, but then it should be set to 
"Shielded", and Windows restarted, in order to prevent a guest user from undoing this icon protection.)

When you do the above, please note that you will have to change the icon back to that of the protected 
application, since Program Manager will have replaced its icon with ProGuard's (unless, of course, you might 
wish to use ProGuard's own icon).    Single-click on the icon to highlight it, click on the File menu, then on 
Properties, and then on Change Icon.    Enter the path for the protected program in the Filename box, and then 
click on OK, and OK again.    The protected application's icon should now be visible again in Program 
Manager.

Note that ProGuard's installation program gives the user the opportunity to create a ProGuard program group, 
with protected icons for File Manager, System Editor, Control Panel, Windows Setup, PIF Editor, and DOS 
Prompt already in it.    (If the ProGuard group was never created, or if it has been deleted, running 
makgroup.exe, located either on the ProGuard diskette, or in the directory in which prgrd-20.zip was unzipped, 
may be used to create the group, if desired.)

See also:

Protection Shield Settings
Password Protection
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ProGuard V.2 allows the authorized user to protect Windows Program Manager against most of the damages 
that might be caused by a guest user.    There are two Protection Shield settings available, accessed from the 
Protection Shield Window.

The Shielded setting prevents guest users (and, in fact, the authorized user) from employing the New, Move, 
Copy, Delete, and Run commands in Program Manager's File Menu.    The Properties command is still 
functional, but the Properties dialog box becomes a read-only control, as all of its fields are "dimmed".    The 
Shielded setting is necessary to prevent a guest user from removing "run" from a protected program's command
line.

The Exposed setting provides no protection to damages done by a guest user (which is, of course, the default 
Windows condition).    The Exposed setting must be used by the authorized user whenever he/she wishes to 
change which icons are to be protected, or any other aspects of Program Manager's configuration.

Note that Windows must be restarted before any change in the ProGuard Protection setting will take place.

Note also that, if the authorized user is also using either WinGuard or StormWindows (two other Windows 
security programs available from Cetus Software), it is recommended that protection settings be changed using 
one of those programs, since they provide finer control over the types and degree of Windows protection than 
does ProGuard.

See also:

ProGuard Security
Protection Shield Window
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In order to restrict access to ProGuard and the programs that it protects, it is necessary for the authorized user 
to use a password.    For the shareware version of ProGuard, the default password at the time of initial 
installation is "shield", but this should be changed to one of the authorized user's own choosing as soon as 
possible.    The actual password is stored in a file, prgrd.dll, in coded form.

If the authorized user ever forgets the password, or if the password file becomes corrupted, then prgrd.dll may 
be deleted;    ProGuard may then be started by using the default password of "shield", and the working 
password may then be chosen once again.    (Note that the registered version of ProGuard comes with a private 
default password individually chosen at the time of registration.)

The password may be changed at any time after the correct password has been entered.    The password must 
consist entirely of letters (not case-sensitive) and/or numbers, with no spaces or punctuation, and is limited to a
maximum of twenty characters.

To make it more difficult for someone else to see the password as the authorized user enters it, the password 
itself does not appear on the screen (except when the working password is actually being changed, which 
should be done in private).    Furthermore, if either a period or comma is typed at the end of the actual 
password, several "decoy" characters may be entered immediately afterward (as ProGuard will only read the 
characters up to the period or comma), so that someone watching the password being entered would have 
trouble even counting how long the password actually is.

See also:

Program Security
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ProGuard may be easily uninstalled with the use of its uninstallation program, uninstal.exe.    For the purpose 
of security, uninstal.exe is not present along with run.exe and its support files in the Windows directory (on a 
networked computer) or in the Windows System directory (on a non-networked PC).    Instead, uninstal.exe 
should be found (depending upon how ProGuard was obtained) either on the original installation diskette, or in 
the subdirectory in which the original prgrd-20.zip file was unzipped.

Please ENSURE that the following is true BEFORE attempting to uninstall ProGuard:    FIRST-The Protection 
Shield setting MUST be set to "Exposed".      SECOND- ProGuard itself must NOT be running.    THIRD- 
Ideally, NO other program (besides Program Manager or File Manager) should be running.

Uninstal.exe will remove most of ProGuard's files.    However, some of the uninstallation must still be done 
manually, as uninstal.exe will not be able to tell exactly which icons have been protected.    Any icon protected 
with "run [filename]" should have the "run" manually deleted from its command line.

Furthermore, uninstal.exe will not delete vbrun300.dll, located in either the Windows directory (on a 
networked computer) or in the Windows System directory (on a non-networked PC), as some other application 
(any other program written in Visual Basic V.3.0) might also need that file.    It must be left up to the authorized
user to decide if vbrun300.dll may be safely deleted.

See also:
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ProGuard is NOT "freeware" !!!
The shareware version of ProGuard is being distributed on a trial basis for evaluation purposes, and is not 
"crippled" in any way, so that you may fairly judge ProGuard thoroughly.    You may install the unregistered, 
shareware version of ProGuard on any one computer, and then try it out for 30 days.    After this trial period 
you MUST either register your use of ProGuard, OR uninstall it, removing it from that computer.    If you do 
indeed find ProGuard to be a useful addition to your computer's hard disk, then you MUST register your use of 
the program;    in doing so you will be entitled to receive on disk a copy of the latest registered version of 
ProGuard, without any "reminder screens".

CLICK ON THIS LINE TO VIEW A REGISTRATION FORM (which optionally may be printed).
On the registration form you are given the opportunity to choose your own private default password (the 
password that may be used to access ProGuard if the password file, prgrd.dll, is deleted).    Selecting a private 
default password will prevent even other knowledgeable ProGuard owners from being able to access your 
ProGuard program.    Note that the password must consist of no more than twenty letters (not case-sensitive) 
and/or numbers, with no spaces or punctuation.    Note also that, if you do not choose a private default 
password, then the default password on your registered copy of ProGuard will remain as "shield".    (Of course, 
the "regular" current password, coded into the prgrd.dll file, may be changed from within ProGuard by you at 
any time.)

A single-user Individual License for ProGuard may be obtained for $14.95.    A Site License for the use of 
ProGuard on any number of computers at ONE specific institutional location may be obtained for $74.95.    
(Note that each of the above prices includes shipping costs.)    Please contact Cetus Software if you wish to 
discuss other licensing arrangements.

An Individual License entitles one individual registered user to install and use ProGuard on any computer(s) 
that he/she personally owns, but he/she must NOT allow his/her registered copy of ProGuard to be installed or 
used on any other computer(s).    A copy of ProGuard registered to an individual user may be installed and used
on his/her own personal computer(s) at an institution, but that personal copy of ProGuard must NOT be 
installed or used on any other computer at that institution, whether belonging to another individual or to that 
institution.

A Site License entitles the registered institution (school building, business office, organization headquarters, 
etc.) to install and use ProGuard on any number of computers belonging to that institution at that specific 
location.    Any institution with multiple locations MUST obtain a separate site license for EACH location.    
Any copy of ProGuard registered to a particular institution location may NOT be distributed beyond the 
boundaries of that institutional site.

However, any person is permitted (and, in fact, ENCOURAGED) to distribute the UNregistered, shareware 
version of ProGuard to others, as long as ALL of its files are distributed together.    For further information on 
ProGuard registration, or to obtain a copy on disk of the shareware version of ProGuard for free distribution 
and evaluation, please contact Cetus Software.

Cetus Software thanks you for trying out ProGuard !!!
See also:

Registration Form
About Cetus Software
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YOU MAY CLICK ON THIS LINE TO PRINT OUT THIS REGISTRATION FORM.

PLEASE TYPE OR PRINT CLEARLY :

Date ___________________________

Name of User (for Individual License) ________________________________________
(or)
Name of Institution (for Site License) ________________________________________
(If multiple Site Licenses are being obtained, please list on the back of this form.)

Mailing Address _________________________________________________

Mailing Address _________________________________________________

Mailing Address _________________________________________________

Daytime Telephone Number (with Area Code) ____________________________

Default Password Choice __________________________________
(Maximum of 20 letters or numbers, with no spaces or punctuation)

Please circle size of diskette desired:          3-1/2"        5-1/4"

Please fill in the appropriate line with the amount you are enclosing:

One Individual License @ $14.95 = $____.95

_____ Site License(s) @ 74.95 = $_____.___

One Individual License Upgrade @ $9.95 = $___.95

_____ Site License Upgrade(s) @ $49.95 = $_____.___

(Massachusetts residents:    Please include 5% state sales tax.)

(Please note that the above prices include shipping and handling costs.)

Please send this Registration Form, along with payment (or purchase order) to:

Cetus Software thanks you for your ProGuard registration !!!

YOU MAY CLICK ON THIS LINE TO PRINT OUT THIS REGISTRATION FORM.





Cetus Software is the creator of several Windows utilities, including WinGuard, StormWindows, PadLock, and 
Reveille, as well as ProGuard.    Shareware versions of these products may be found on several bulletin board 
systems, or may be obtained on diskette directly from Cetus Software for a nominal charge ($5.00 each, 
postpaid).

Please direct all inquiries regarding Cetus Software's products to:

Internet E-Mail Address:    fwcetus@aol.com
See also:

WinGuard Introduction
StormWindows Introduction
PadLock Introduction
Reveille Introduction
ProGuard Registration
Registration Form
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In addition to ProGuard, Cetus Software offers a related security program, WinGuard, offering protection on a 
more "global" scale than ProGuard.    WinGuard is designed to shield Program Manager itself, unlike ProGuard
(which is, of course, intended primarily to password-protect individual Program Manager icons).

WinGuard can protect a Windows 3.1 computer from having any of its Program Manager groups or icons 
rearranged or damaged. This protection would probably be the most useful to someone in charge of a number 
of computers at a school or business, though a parent might wish to prevent little fingers on a mouse from 
dragging all of the Program Manager icons into a (not so) nice "happy face"!

WinGuard can also hide "sensitive" programs (such as Windows Setup, Control Panel, or File Manager), as 
well as selected Program Manager groups and Control Panel icons, behind its password-protected shell, 
restricting access to them to the authorized user only.

Thus, it can be seen that WinGuard may be used to configure the Program Manager interface to allow easy 
access to selected applications for a guest user, while minimizing the chances of damage (accidental or 
intentional) to Windows and the programs accessed through it.

The shareware version of WinGuard is available on several bulletin board systems, or may be obtained on 
diskette in uncompressed form, directly from Cetus Software for $5.00 (postpaid).

See also:

About Cetus Software
Introduction to StormWindows
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In addition to ProGuard, Cetus Software offers a related security program, StormWindows, offering essentially 
the same functions as another Cetus product, WinGuard, but depending on an entirely different means of 
ensuring security.

Like WinGuard, StormWindows can protect a Windows 3.1 computer from having any of its Program Manager
groups or icons rearranged or damaged.    StormWindows can also hide "sensitive" programs, such as Windows
Setup, Control Panel, or File Manager, as well as selected Program Manager groups and Control Panel icons.

StormWindows' protections would probably be the most useful to someone in charge of a number of computers
at a business or at a school.    For security purposes, StormWindows is designed to perform its functions 
directly from a diskette, kept in the possession of the authorized user, and thus StormWindows can 
conveniently provide ideal protection to any number of Windows computers on display in a store, without 
requiring any hard disk installations.

The shareware version of StormWindows is available on several bulletin board systems, or may be obtained on 
diskette in uncompressed form, directly from Cetus Software (P.O. Box 700, Carver, MA 02330 USA) for a 
nominal charge ($5.00, postpaid).

See also:

About Cetus Software
Introduction to WinGuard
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PadLock may be used to "lock out" unauthorized users from accessing Windows or any Windows application.   
While PadLock is running, no keyboard or mouse command will have any effect outside of the PadLock 
window itself.    Entry of the proper password (chosen by the authorized user) is required to access any of 
PadLock's controls or to end its protection.

PadLock may be configured to "lock up" Windows automatically at startup, or PadLock may simply be run 
whenever the authorized user desires to "freeze" Windows (such as when leaving the computer unattended), 
preventing any access by unauthorized users.    PadLock even provides the authorized user with the means to 
edit system files, and to exit Windows, restart Windows, or reboot the computer from within itself.

The shareware version of PadLock is available on several bulletin board systems, or may be obtained on 
diskette in uncompressed form, directly from Cetus Software (P.O. Box 700, Carver, MA 02330 USA) for a 
nominal charge ($5.00, postpaid).

See also:

About Cetus Software
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Reveille is a Windows application that will play musical tunes, either on demand while it is running, or at start-
up using command line parameters sent it by a separate timer or scheduler application (and a timer application 
for this purpose is included).    A reminder message may be specified in the command line that starts the 
program, and Reveille will display it in the Status Bar at the bottom of the Reveille window at the designated 
time.

Reveille tunes are stored in simple ASCII text files that emulate BASIC "play" strings (which, in fact, may be 
imported into Reveille).    Tune files (18 of which are included) may be created and/or edited from within 
Reveille (or by using any plain-ASCII text editor, such as Notepad), and groups of tunes may be compiled and 
saved as compilation files.    A sound card is NOT required, as Reveille will play directly through a PC's own 
speaker.

The shareware version of Reveille is available on several bulletin board systems, or may be obtained on 
diskette in uncompressed form, directly from Cetus Software (P.O. Box 700, Carver, MA 02330 USA) for a 
nominal charge ($5.00, postpaid).

See also:

About Cetus Software
HELP INDEX



Cancel Command Button
In the Password Entry Window (if a command line has been specified), the Cancel command button may be 
used to exit ProGuard before running the protected application.

In the New Password Window, the Cancel command button may be used to return to the Password Entry 
Window without accepting a new password.



Close Command Button
In the Protection Shield Window, the Close command button may be used to return to the Password Entry 
Window without restarting Windows.



Exit Command Button
In the Password Entry Window (when a command line has not been specified), the Exit button may be used to 
exit from ProGuard.

The Exit button may also be found in the Password Entry Window, after returning to the Password Entry 
Window from one of the other windows.    In this context, the Exit button may be used to exit from ProGuard 
without further action.



Exposed Setting
The Exposed Protection setting provides no protection to Program Manager or its groups or icons.    Ordinarily, 
the Exposed setting may be temporarily utilized by the authorized user, in order to change Program Manager 
configuration or icon properties.

While it is possible to utilize ProGuard's command line protection (password-protecting individual icons) using
the Exposed setting (without the Shielded setting), this is not recommended, since a more knowledgeable 
Windows user would be able to remove the "run" before an application's filename, and thus work around 
ProGuard's protection.

Any change in ProGuard's Protection setting will necessitate Windows being restarted before the new setting 
takes effect.



File Menu
The File Menu, found in each of ProGuard's windows, includes menu items for performing the functions of 
each window.

Note that, in the Password Entry Window, the Set Shield, New Password, and New Command Line menu items
will be "dimmed" until the correct password has been entered in the Password Entry Box.



Help Menu
The Help Menu, found in each of ProGuard's windows, provides access to this Help File.    In addition, the 
Password Entry Window's Help Menu also provides information on ProGuard and its registration.



New Command Line Menu Item
The New Command Line menu item, found in the Password Entry Window's File Menu, is used to enter a new 
command line for ProGuard to run.

The New Command Line menu item will be "dimmed" until the correct password has been entered in the 
Password Entry Box.



New Password Menu Item
The New Password command, found in the Password Entry Window's File Menu, is used to access the New 
Password Window, in order to change the working password.

The New Password menu item will be "dimmed" until the correct password has been entered in the Password 
Entry Box.



OK Command Button
In the New Password Window, once the new password has been entered in the Password Entry Box, the OK 
command button may be used to accept the new password and return to the Password Entry Window.



Password Entry Box
In the Password Entry Window, the Password Entry Box is employed to enter the password used to access 
ProGuard.    Note that the password must be entered correctly within three tries or the Password Entry Window 
closes itself.

Once the password has been entered correctly, the Run command button may be pressed (to start the protected 
application, if a command line has been specified), or the previously "dimmed" Set Shield, New Password, and
New Command Line menu items may be accessed.

In the New Password Window, the Password Entry Box is employed to enter a new password, after which the 
OK command button should be pressed to return to the Password Entry Window.



Restart Command Button
The Restart Button, found in the Protection Shield Window, may be used to exit and then restart Windows, in 
order to bring about a change in the ProGuard Protection setting.



Run Command Button
The Run Button (found in the Password Entry Window) may be used to execute a protected program, if a 
command line has been specified.    (Note that the Run command will be disabled if a command line has not 
been specified.)



Set Shield Menu Item
The Set Shield command, found in the Password Entry Window's File Menu, is used to access the Protection 
Shield Window, in order to enable or disable ProGuard's Protection Shield.

The Set Shield menu item will be "dimmed" until the correct password has been entered in the Password Entry 
Box.



Shielded Setting
The Shielded Protection setting protects Program Manager, its program groups, and program items (icons) 
from most forms of damage that can be done by a guest user.    In particular, the Shielded setting is essential to 
keeping a guest user from modifying a protected icon's command line in order that he/she may start a protected 
icon's application.

The Shielded setting prevents a guest user (and, in fact, the authorized user) from employing the New, Move, 
Copy, Delete, and Run commands in Program Manager's File Menu, as ProGuard will cause each of them to be
"dimmed".    The Properties command will still be functional, but the Properties dialog box becomes a read-
only control, as all of its fields will also be "dimmed".

Any change in ProGuard's Protection setting will necessitate Windows being restarted before the new setting 
takes effect.



"dim"
to disable a menu command, making it non-functional (also referred to as "grayed out")



"dimmed"
the appearance of a disabled, non-functional menu item (also referred to as "grayed out")



Authorized User
the person using a computer with ProGuard installed who, by the use of a password, is able to modify and/or 
bypass ProGuard's protections



Guest User
any person allowed to use a computer with ProGuard installed who may be restricted by ProGuard from accessing 
certain programs






